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Important User Information

Solid state equipment has operational characteristics differing from those of electromechanical equipment. 
Safety Guidelines for the Application, Installation and Maintenance of Solid State Controls (Publication 
SGI-1.1 available from your local Rockwell Automation sales office or online at www.ab.com/manuals/gi) 
describes some important differences between solid state equipment and hard-wired electromechanical 
devices. Because of this difference, and also because of the wide variety of uses for solid state equipment, all 
persons responsible for applying this equipment must satisfy themselves that each intended application of 
this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages 
resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many 
variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot 
assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, 
equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell 
Automation, Inc., is prohibited.

Throughout this manual we use notes to make you aware of safety considerations.

WARNING
Identifies information about practices or circumstances that can cause an explosion in a 
hazardous environment, which may lead to personal injury or death, property damage, 
or economic loss.

IMPORTANT Identifies information that is critical for successful application and understanding of the 
product.

ATTENTION Identifies information about practices or circumstances that can lead to personal injury 
or death, property damage, or economic loss. Attentions help you:

• identify a hazard

• avoid a hazard

• recognize the consequence

SHOCK HAZARD Labels may be located on or inside the equipment to alert people that dangerous 
voltage may be present.

BURN HAZARD Labels may be located on or inside the equipment to alert people that surfaces may be 
dangerous temperatures.
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Environment and Enclosure

Preventing Electrostatic Discharge

ATTENTION This equipment is intended for use in a Pollution Degree 2 industrial environment, 
in overvoltage Category II applications (as defined in IEC publication 60664-1), at 
altitudes up to 2000 meters without derating.

This equipment is considered Group 1, Class A industrial equipment according to 
IEC/CISPR Publication 11. Without appropriate precautions, there may be 
potential difficulties ensuring electromagnetic compatibility in other environments 
due to conducted as well as radiated disturbance.

This equipment is supplied as �open type� equipment. It must be mounted within 
an enclosure that is suitably designed for those specific environmental conditions 
that will be present and appropriately designed to prevent personal injury resulting 
from accessibility to live parts. The interior of the enclosure must be accessible only 
by the use of a tool. Subsequent sections of this publication may contain additional 
information regarding specific enclosure type ratings that are required to comply 
with certain product safety certifications.

NOTE: See NEMA Standards publication 250 and IEC publication 60529, as 
applicable, for explanations of the degrees of protection provided by different 
types of enclosure. Also, see the appropriate sections in this publication, as well as 
the Allen-Bradley publication 1770-4.1 (�Industrial Automation Wiring and 
Grounding Guidelines�), for additional installation requirements pertaining to this 
equipment.

ATTENTION This equipment is sensitive to electrostatic discharge, which can cause internal 
damage and affect normal operation. Follow these guidelines when you handle this 
equipment:

• Touch a grounded object to discharge potential static.
• Wear an approved grounding wriststrap.
• Do not touch connectors or pins on component boards.
• Do not touch circuit components inside the equipment.
• If available, use a static-safe workstation.
• When not in use, store the equipment in appropriate static-safe packaging.
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Hazardous Location Approval

The following information applies when 
operating this equipment in hazardous 
locations:

Informations sur l’utilisation de cet équipement en 
environnements dangereux:

Products marked “CL I, DIV 2, GP A, B, C, D” are 
suitable for use in Class I Division 2 Groups A, B, C, D, 
Hazardous Locations and nonhazardous locations only. 
Each product is supplied with markings on the rating 
nameplate indicating the hazardous location 
temperature code. When combining products within a 
system, the most adverse temperature code (lowest 
“T” number) may be used to help determine the 
overall temperature code of the system. Combinations 
of equipment in your system are subject to 
investigation by the local Authority Having 
Jurisdiction at the time of installation.

Les produits marqués "CL I, DIV 2, GP A, B, C, D" ne 
conviennent qu’à une utilisation en environnements de 
Classe I Division 2 Groupes A, B, C, D dangereux et non 
dangereux. Chaque produit est livré avec des marquages 
sur sa plaque d’identification qui indiquent le code de 
température pour les environnements dangereux. 
Lorsque plusieurs produits sont combinés dans un 
système, le code de température le plus défavorable 
(code de température le plus faible) peut être utilisé pour 
déterminer le code de température global du système. 
Les combinaisons d’équipements dans le système sont 
sujettes à inspection par les autorités locales qualifiées 
au moment de l’installation.

WARNING
EXPLOSION HAZARD

• Do not disconnect equipment 
unless power has been 
removed or the area is known 
to be nonhazardous. 

• Do not disconnect 
connections to this 
equipment unless power has 
been removed or the area is 
known to be nonhazardous. 
Secure any external 
connections that mate to this 
equipment by using screws, 
sliding latches, threaded 
connectors, or other means 
provided with this product.

• Substitution of components 
may impair suitability for 
Class I, Division 2.

• If this product contains 
batteries, they must only be 
changed in an area known to 
be nonhazardous.

AVERTISSEMENT RISQUE D’EXPLOSION

• Couper le courant ou 
s’assurer que 
l’environnement est 
classé non dangereux 
avant de débrancher 
l'équipement.

• Couper le courant ou 
s'assurer que 
l’environnement est 
classé non dangereux 
avant de débrancher les 
connecteurs. Fixer tous 
les connecteurs externes 
reliés à cet équipement à 
l'aide de vis, loquets 
coulissants, connecteurs 
filetés ou autres moyens 
fournis avec ce produit.

• La substitution de 
composants peut rendre 
cet équipement inadapté 
à une utilisation en 
environnement de Classe 
I, Division 2.

• S’assurer que 
l’environnement est 
classé non dangereux 
avant de changer les 
piles.
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Windows 2000, NT, and XP are trademarks of Microsoft Corporation.

RSLogix5000, RSNetWorx, RSLinx, and IOLinx are trademarks of Rockwell Automation.

WARNING
If you connect or disconnect the communications cable with power applied to 
this module or any device on the network, an electrical arc can occur. This 
could cause an explosion in hazardous location installations.

When used in a Class I, Division 2, hazardous location, this equipment must be 
mounted in a suitable enclosure with proper wiring method that complies with 
the governing electrical codes.

If you insert or remove the card while host power is on, an electrical arc can 
occur. This could cause an explosion in hazardous location installations.

Be sure that power is removed or the area is nonhazardous before proceeding.
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Preface

About the 1784-PKTCS Universal PCI Scanner 
Card

What Is a 1784-PKTCS Universal PCI Scanner Card?
The ControlNet 1784-PKTCS card is a Universal Peripheral Component Interconnect (PCI) 
open-bus interface card. The card enables PCI local bus compatible computers to 
communicate directly with other ControlNet products.

The 1784-PKTCS scanner card provides ControlNet I/O scanning as well as monitoring and 
configuration capabilities.

Purpose of This Manual
Use this document to learn how to install and use the 1784-PKTCS scanner card.

Intended Audience
Read this manual before you install or use the ControlNet PCI communication interface 
cards. You should be familiar with ControlNet technology when applying products such as 
those described in this publication.

For Information On This Topic Refer To Page

About the 1784-PKTCS Universal PCI Scanner Card 7

Purpose of This Manual 7

Intended Audience 7

Terminology 8

What Your Package Contains 8

For Further Reference 8
Publication 1784-IN042A-EN-P - April 2005
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8        Preface 
Terminology

What Your Package Contains
With this package you should receive:

• one 1784-PKTCS card
• one IOLinx 1784-PKTCS driver CD-ROM
• ControlNet Universal PCI Scanner Card Installation Instructions, publication 

1784-IN042

For Further Reference
Refer to these publications for more information on installing and using your 1784-PKTCS 
card:

this term means

ControlNet networking standard maintained by ControlNet 
International

PCI peripheral component interconnect

Publication 
Number

Publication Title

CNET-UM001 ControlNet Communication Modules in Logix5000 Control System User Manual

1789-UM002 SoftLogix5800 System User Manual

CNET-IN002 ControlNet Coax Media Planning and Installation Guide

9230-IOLINXSDK IOLinx Software Development Kit
Publication 1784-IN042A-EN-P - April 2005
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Chapter 1

Install IOLinx

Uninstall the Previous Version of IOLinx

1. Shut down all applications that use the IOLinx ControlNet Driver, including RSLinx 
and SoftLogix.

2. Click on IOLinx for ControlNet to remove it.

3. Select Remove.

For Information On This Topic Refer To Page

Uninstall the Previous Version of IOLinx 1-1

Install IOLinxInstall IOLinx 1-2

IMPORTANT Do not install the 1784-PKTCS ControlNet Universal PCI scanner card 
in the same PC as a 1784-KTCS ControlNet ISA-bus scanner card. Before 
installing the 1784-PKTCS card, remove all the 1784-KTCS cards and 
uninstall the associated drivers. 

IMPORTANT Before you update the new driver and IOLinx, you must uninstall any 
earlier versions of IOLinx. If you do not currently have IOLinx installed, 
go to the Install IOLinx procedure on page 1-2.

in this operating system: select:

Windows 2000 Start ⇒Settings  ⇒Control Panel, then double-click the 
Add/Remove Programs icon

Windows XP Start ⇒Control Panel ⇒Add or Remove Programs, or 
Start ⇒Control Panel, then double-click the Add or Remove 
Programs icon
Publication 1784-IN042A-EN-P - April 2005
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1-2        Install IOLinx 
4. Select Yes to uninstall IOLinx.

5. Reboot the computer.

Install IOLinx

1. Insert the CD in the computer�s CD-ROM drive or access the compressed file you 
downloaded and saved to a temporary directory.

2. If you are installing from CD-ROM and Autorun is enabled for your CD-ROM drive, 
go to step 5 on page 1-3.

3. Select Start ⇒Run.

TIP If you are prompted to remove unused shared files, select No to All.

IMPORTANT We recommend that you exit all Windows programs before running this 
Setup program.

TIP The CD-ROM supports Windows Autorun. If you have Autorun 
configured, once the CD is inserted into the CD-ROM drive, the 
installation will automatically start at the first setup screen.
Publication 1784-IN042A-EN-P - April 2005
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Install IOLinx        1-3
4. At the Run pop-up window, type x:\setup where x is the drive where the installation 
files are stored. You see the ControlNet Universal PCI Scanner Card screen.

5.  Select Install IOLinx for ControlNet.

6. If the Microsoft .NET Framework is already installed on your computer, go 
to step 10.

If the Microsoft .NET Framework is not installed on your PC, you will be prompted 
to install it.

7. Click Yes to install the Microsoft .NET Framework. 

8. Follow the on-screen instructions to install the software.

9. When you have finished installing the.NET Framework, return to step 5.
Publication 1784-IN042A-EN-P - April 2005
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1-4        Install IOLinx 
10. Click Next. 

11. Use the default path to the folder. Select the Everyone or Just me radio button, 
depending on your application.

12. Click Next. You see the Confirm Installation screen.
Publication 1784-IN042A-EN-P - April 2005
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Chapter 2

Install the 1784-PKTCS Card

Before You Begin
To install the card, you need to:

• access the computer�s expansion slots
• insert the card into the computer

For Information On This Topic Refer To Page

Before You Begin 2-1

Access the Computer’s PCI Local Bus Expansion Slots 2-2

Insert the Card into the Computer 2-2

Connect to the Network 2-3

Connect the Card Directly to the ControlNet Network 2-5

Connect to a Device on the ControlNet Network 2-6

IMPORTANT The card�s dimensions are shown below.

4.2 in. 
10.7 cm

6.5 in. 
16.5 cm

31474-M
Publication 1784-IN042A-EN-P - April 2005
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2-2        Install the 1784-PKTCS Card 
Access the Computer’s PCI Local Bus Expansion Slots
To install the card, you must access the computer�s PCI local bus expansion slots. Follow 
these general steps, or refer to your computer�s user guide for further instructions:

1. Shut down the host computer.

2. Remove the computer�s cover.

3. Select a vacant PCI local bus expansion slot.

4. Loosen the screw (if present) on the back (rear bracket) of the computer.

5. Remove the slot�s expansion cover. 

Insert the Card into the Computer

To insert the card inside the computer:

1. Handle the card so that you prevent electrostatic discharge. Refer to the Preface of 
this manual for more information.

2. Insert the card into the edge connector and tighten the expansion slot screw (if 
present).

3. Replace the computer�s cover.

WARNING When used in a Class I, Division 2, hazardous location, this 
equipment must be mounted in a suitable enclosure with prop-
er wiring method that complies with the governing electrical 
codes.
If you insert or remove the card while host power is on, an 
electrical arc can occur. This could cause an explosion in haz-
ardous location installations.
Be sure that power is removed or the area is nonhazardous be-
fore proceeding.
Publication 1784-IN042A-EN-P - April 2005
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Install the 1784-PKTCS Card        2-3
4. Turn on the computer to be certain that it comes up correctly.

Connect to the Network

After you have installed the card, you can connect it:

• directly to a ControlNet network, which requires a tap (page 2-5)
• to a device already connected to the ControlNet network (page 2-6)

See Figure 2.1 on page 2-4 for the connectors and indicators. 

If the computer: then:

powers up go on to the next section, Connect to the Network , on page 2-3

hangs up either the card is not seated correctly in the PCI slot or you have a 
memory or I/O conflict. You should:

•  remove and reinsert the card into the same PCI slot and 
try again

• remove and reinsert the card into a different PCI slot and 
try again

•  remove all other non-essential cards and try again

If you continue to experience difficulty, contact your local 
Rockwell Automation sales representative or distributor, or call 
Rockwell Automation Technical Support at 440.646.5800.

WARNING If you connect or disconnect the ControlNet cable with power applied 
to this module or any device on the network, an electrical arc can 
occur. This could cause an explosion in hazardous location 
installations.
Publication 1784-IN042A-EN-P - April 2005
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2-4        Install the 1784-PKTCS Card 
Figure 2.1  1784-PKTCS card

ATTENTION Do not connect different ControlNet networks to this card. If you 
attempt to connect a second network to this card, your 
communication system will operate erratically.

A

B

Network Access Port (NAP)
RJ-45 connector for connecting 
programming terminals to devices on 
a ControlNet network

Channel A  
BNC connectors for connecting directly to 
ControlNet network

Channel B

Do not connect different 
ControlNet networks to this card.

Redundant media 
BNC connectors

Diagnostic status 
indicators

42281

!

!

! !

Allen-Bradley
1784-PKTCS
ControlNet
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Install the 1784-PKTCS Card        2-5
Connect the Card Directly to the ControlNet Network
To connect the card directly to a ControlNet network as shown in Figure 2.2, follow the 
instructions in these publications:

• ControlNet Coax Tap Installation Instructions, publication 1786-IN007
• ControlNet Coax Media Planning and Installation Manual, publication CNET-IN002

Figure 2.2  Connect the card directly to the ControlNet network

ATTENTION If you connect the product to a cable system that does not support 
redundant media, connect the tap dropline to the BNC connector 
labeled channel A. Channel B is left unconnected. 
 
If the cable system is redundant, connect the product so that all 
devices on the network use the same cable for the same channel. That 
is, all channel A connectors connect to one cable; all channel B 
connectors connect to the other cable.

TIP If you use a non-redundant cable system, all ControlNet devices must 
be on the same channel, channel A. 

Desktop host 
computer

1784-PKTCS

1786-TPR, -TPS, -TPYR, or -TPYS tap

ControlNet network

42200
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2-6        Install the 1784-PKTCS Card 
Connect to a Device on the ControlNet Network
The 1786-CP cable (Figure 2.3) connects a host computer to another ControlNet device. It 
has two RJ-45 8-pin connectors.

Figure 2.3  1786-CP cable

See Table 2.1 and Table 2.2 for the wiring for the 1786-CP cable.

ATTENTION Use only the 1786-CP cable when you connect a programming 
terminal to the network through the network access port (NAP). If 
you use a different cable, it could result in possible network failures 
or product damage.

Table 2.1  Wiring for 1786-CP connector cable

Connector 1

Wire Number Signal Mnemonic Signal Name

1 ISO-GND Isolated Ground

2 N.C. No Connection

3 PTTX-H Transmit Data High

4 PTTX-L Transmit Data Low

5 PTRX-L Receive Data Low

6 PTRX-H Receive Data High

7 N.C. No Connection

8 ISO-GND Isolated Ground

RJ-45 8-pin connectors

1786-CP cable

30124-m

Connector 1 Connector 2
Publication 1784-IN042A-EN-P - April 2005
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Install the 1784-PKTCS Card        2-7
When you use the RJ-45 connector, you can connect the card to a ControlNet network 
without a tap through the Network Access Port (or NAP) of a programmable controller, I/O 
adapter, or other ControlNet compliant devices (Figure 2.4 and Figure 2.5).

Table 2.2  Wiring for 1786-CP connector cable

Connector 2

Wire Number Signal Mnemonic Signal Name

1 ISO-GND Isolated Ground

2 N.C. No Connection

3 PTRX-H Receive Data High

4 PTRX-L Receive Data Low

5 PTTX-L Transmit Data Low

6 PTTX-H Transmit Data High

7 N.C. No Connection

8 ISO-GND Isolated Ground
Publication 1784-IN042A-EN-P - April 2005
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2-8        Install the 1784-PKTCS Card 
Figure 2.4  Connect a programming terminal to a ControlNet network through 
another ControlNet device  

 

ATTENTION If the 1784-PKTCS card is using scheduled communication to control 
I/O, or produce or consume tags, do not use the 1786-CP cable to 
connect the card to the ControlNet network. Instead, connect the 
card directly to the ControlNet network as shown in Figure 2.2.

1 The 1786-CP cable can be plugged into any ControlNet product’s NAP to provide programming capability on 
the ControlNet network. When you connect a programming terminal through this cable, it is counted as a 
node and must have a unique address.

ControlNet network

Programming 
terminal

1784-PKTCS
1786-CP cable1

ControlNet 
product

42199
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Install the 1784-PKTCS Card        2-9
Figure 2.5 Connect a portable host computer to the ControlNet network through 
the 1784-PKTCS card

What Is Next?

In This Operating System Do This

Windows XP go on to Chapter 3 to install the driver

Windows 2000 go on to Chapter 4 to install the driver

Portable host 
computer

1784-PKTCS

1784-PCC
Desktop host 
computer

1784-PCC1 cable

ControlNet network

42198
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Chapter 3

Install the Driver in Windows XP

Install the Driver in Windows XP for the First Time

For Information On This Topic Refer To Page

Install the Driver in Windows XP for the First Time 3-1

Update the Existing Driver in Windows XP 3-3

IMPORTANT Be sure that your 1784-PKTCS card is properly installed. Refer to 
Chapters 1 and 2 of this manual to install the card. 

IMPORTANT Use this procedure if this is the first time that you are installing the 
1784-PKTCS driver and IOLinx on this computer. Otherwise, use the 
Update the Existing Driver in Windows XP procedure on page 3-3 
instead of this procedure.
Publication 1784-IN042A-EN-P - April 2005
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3-2        Install the Driver in Windows XP 
1. When you boot up your computer for the first time after installing your 1784-PKTCS 
card, you see the Found New Hardware Wizard screen.

2. Select the Install from a list or specific location (Advanced) radio button.

3. Click Next.

4. Click the Search for the best driver in these locations radio button.

5. Check the Include this location in the search checkbox and uncheck the remaining 
checkboxes.
Publication 1784-IN042A-EN-P - April 2005
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Install the Driver in Windows XP        3-3
6. In the Found New Hardware wizard, click Browse and browse to this location:

x:\Program Files\Rockwell Software\IOLinx\IOLinx for ControlNet\Drivers

where x:\ is the drive where IOLinx is installed.

7. Click OK.

8. Click Next. 

9. Click Finish.

10. Shut down and re-start the PC.

 The driver is now ready to use. Go on to Chapter 5.

Update the Existing Driver in Windows XP

1. Select Start.

2. Right-click My Computer.

IMPORTANT If prompted to overwrite existing files, click Yes.

IMPORTANT Use this procedure only if you have previously installed the 1784-PKTCS 
driver and IOLinx on this computer. If you have not previously installed 
the 1784-PKTCS driver and IOLinx on this computer, use the Install the 
Driver in Windows XP for the First Time procedure on page 3-1 instead 
of this procedure.

IMPORTANT During the update procedure, communication through the card will be 
disrupted.
Publication 1784-IN042A-EN-P - April 2005
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3-4        Install the Driver in Windows XP 
3. Click Manage.

4. In the left window pane, click the + to the left of System Tools to open it.

5. Under System Tools, click Device Manager.

6. In the right window pane, click the + to the left of A-B Virtual Backplane to 
expand it.

7. Right-click A-B 1784-PKTCS.

TIP If you see more than one A-B 1784-PKTCS entry, perform the update 
on only one of the entries.
Publication 1784-IN042A-EN-P - April 2005
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Install the Driver in Windows XP        3-5
8. Click Update Driver. The Hardware Update Wizard appears.

9. Select the Install from a list or specific location (Advanced) radio button.

10. Click Next.

11. Click the Don�t search. I will choose the driver to install radio button.

12. Click Next.

13. Click Have Disk.
Publication 1784-IN042A-EN-P - April 2005

User
新建印章



3-6        Install the Driver in Windows XP 
14. Click Browse and browse to this location:

x:\Program Files\Rockwell Software\IOLinx\IOLinx for ControlNet\Drivers

where x:\ is the drive where IOLinx is installed.

15. Click Open.

16. Click OK.

17. Click A-B 1784-PKTCS to highlight it.

18. Click Next. 

19. Click Finish.

20. Shut down and re-start the PC.

The driver is now ready to use. Go on to Chapter 5.

IMPORTANT If prompted to overwrite existing files, click Yes.
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Chapter 4

Install the Driver in Windows 2000

Install the Driver in Windows 2000 for the First Time

For Information On This Topic Refer To Page

Install the Driver in Windows 2000 for the First Time 4-1

Update the Existing Driver in Windows 2000 4-4

IMPORTANT Be sure that your 1784-PKTCS card is properly installed. Refer to 
Chapters 1 and 2 of this manual to install the card. 

IMPORTANT Use this procedure if this is the first time that you are installing the 
1784-PKTCS driver and IOLinx on this computer. Otherwise, use the 
Update the Existing Driver in Windows 2000 procedure on page 4-4 
instead of this procedure.
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4-2        Install the Driver in Windows 2000 
1. When you boot up your computer for the first time after installing your 1784-PKTCS 
card, you see the Found New Hardware Wizard screen.

2. Click Next.

3. Click the Search for a suitable driver for my device (recommended) radio button.

4. Click Next.
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Install the Driver in Windows 2000        4-3
.

5. Check the Specify a location checkbox and uncheck the remaining checkboxes.

6. Click Next.
Publication 1784-IN042A-EN-P - April 2005

User
新建印章



4-4        Install the Driver in Windows 2000 
7. In the Found New hardware wizard, click Browse and browse to this location:

 x:\Program Files\Rockwell Software\IOLinx\IOLinx for 
ControlNet\Drivers\abpktcs.inf

where x:\ is the drive where IOLinx is installed.

8. Click Open.

9. Click OK.

10. Click Next to install the new driver.

11. Click Finish to close the Found New Hardware Wizard.

12. Shut down and re-start the PC.

The driver is now ready to use. Go on to Chapter 5.

Update the Existing Driver in Windows 2000

IMPORTANT If prompted to overwrite existing files, click Yes.

IMPORTANT Use this procedure only if you have previously installed the 1784-PKTCS 
driver and IOLinx on this computer. If you have not previously installed 
the 1784-PKTCS driver and IOLinx on this computer, use the Install the 
Driver in Windows 2000 for the First Time procedure on page 4-1 
instead of this procedure.

IMPORTANT During the update procedure, communication through the card will be 
disrupted.
Publication 1784-IN042A-EN-P - April 2005

User
新建印章



Install the Driver in Windows 2000        4-5
1. Right-click My Computer.

2. Click Manage.

3. In the left window pane, click the + to the left of System Tools to open it.

4. Under System Tools, click Device Manager

5. In the right window pane, click the + to the left of A-B Virtual Backplane to 
expand it.

6. Right-click A-B 1784-PKTCS.

7. Click Properties.

TIP If you see more than one A-B 1784-PKTCS entry, perform the update 
on only one of the entries.
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4-6        Install the Driver in Windows 2000 
8. Click the Driver tab.

9. Click Update Driver. The Upgrade Device Driver Wizard appears.

10. Click Next.

11. Click the Display a list of the known drivers for this device so I can choose a 
specific driver radio button.

12. Click Next.
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Install the Driver in Windows 2000        4-7
13. Click Have Disk.

14. Click Browse and browse to this location:

x:\Program Files\Rockwell Software\IOLinx\IOLinx for 
ControlNet\Drivers\abpktcs.inf

where x:\ is the drive where IOLinx is installed.

15. Click Open.

16. Click OK.
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4-8        Install the Driver in Windows 2000 
17. Click A-B 1784-PKTCS to highlight it.

18. Click Next.

19. Click Next to install the new driver.

20. Click Finish.

21. Close the A-B 1784-PKTCS Properties screen.

22. Close the Device Manager screen.

23. Shut down and re-start the PC.

The driver is now ready to use. Go on to Chapter 5.

IMPORTANT If prompted to overwrite existing files, click Yes.
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Chapter 5

Once You Have Completed the Installation

Once you have installed the card and drivers, you can do the following:

Register the EDS File

1. To obtain the EDS file, do one of the following:

• on the 1784-PKTCS Driver CD supplied with your card, browse to:

   \EDS Files\0001000C00700400.eds

• download from http://www.ab.com/networks/eds/0001000C00700400.eds

2. Use the EDS wizard in either RSLinx or RSNetWorx for ControlNet software to 
register the EDS file for the 1784-PKTCS card
• In Windows, select Start ⇒Programs ⇒Rockwell Software ⇒RSLinx Tools 
⇒EDS Hardware Installation Tool.
• In RSNetWorx for ControlNet, select Tools ⇒EDS Wizard.

For Information On This Topic Refer To Page

Register the EDS File 5-1

Configure the Card 5-2

Configure a Virtual Backplane Driver in RSLinx Software 5-3

Configure the Scan List 5-4

Go On Line With RSNetWorx for ControlNet Software 5-4
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5-2        Once You Have Completed the Installation 
Configure the Card
Use the IOLinx configuration application to set the card�s ControlNet node address, IOLinx 
port number, and virtual backplane slot.

1. If the IOlinx gears do not appear in the system tray, start the IOLinx configuration 
application by selecting Start ⇒Programs ⇒Rockwell Software ⇒IOLinx for 
ControlNet ⇒IOLinx for ControlNet.

2. Open the IOLinx configuration application by double-clicking the IOLinx gears in 
the system tray.

3. Double-click the row corresponding to the scanner card you want to configure.

TIP The IOLinx configuration application shows all of the installed cards. 
Be certain to select the correct card.

IOLinx gears

double-click the card you want
to configure
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Once You Have Completed the Installation        5-3
4. You see the Port Configuration screen.

5. Close the IOLinx configuration application.

Configure a Virtual Backplane Driver in RSLinx Software

1. Open RSLinx software.

2. Select Communications ⇒Configure Drivers...

3. On the Configure Drivers menu, select Virtual Backplane (SoftLogix 58xx)� from 
the Available Driver Types menu.

4. Click on Add New.

5. Enter a name for the driver and click on OK.

6. Click on Close.

The Virtual Backplane driver is now available to use.

In This Field Do This

ControlNet Address select an unused ControlNet address from the pull-down menu

IOLinx Port Number select an unused IOLinx port number from the pull-down menu

Slot Number select an unused virtual backplane slot address from the pull-down menu 
(note that this is not the physical PCI slot in which the card is inserted)

Disable Device uncheck the checkbox
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5-4        Once You Have Completed the Installation 
Configure the Scan List
Use RSNetWorx for ControlNet to configure the scan list for the 1784-PKTCS card. Refer to 
publication CNET-UM001, ControlNet Modules in Logix5000 Control Systems User 
Manual, for details. 

Go On Line With RSNetWorx for ControlNet Software
When going on line with RSNetWorx for ControlNet software via the 1784-PKTCS card:

1. Double-click on the + sign to the left of the Virtual Chassis.

2. Double-click on the + sign to the left of the 1784-PKTCS card to expand it.

3. Click on Port A, ControlNet.

Select Port A, ControlNet
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Once You Have Completed the Installation        5-5
When You Use RSNetWorx for ControlNet Software
Keep the following in mind when you use RSNetWorx for ControlNet software.

1784-PKTCS Card Will Not Establish Connections Until Output Data is Initialized

The 1784-PKTCS card will not establish new or modified connections that require data to be 
produced by the 1784-PKTCS card until the controlling application has initialized the output 
data.

Examples of controlling applications include:

• RSView applications
• IOView test application
• Custom IOLinx applications

Examples of connection types that require output data from a controlling application include:

• Exclusive Owner connections to I/O racks
• Exclusive Owner connections to I/O modules
• Send Data connections

Examples of connection types that do not require output data from a controlling application 
include:

• Input Only connections to I/O racks
• Input Only connections to I/O modules
• Listen Only connections to I/O racks
• Listen Only connections to I/O modules
• Receive Data From connections

For Information On This Topic Refer To

Using The IOView Test Application Chapter 6 of this manual

Creating Custom IOLinx Applications the IOLinx Software Development Kit (catalog 
number 9230-IOLINXSDK) online help

If The Controlling Application Has Not 
Provided Output Data For A(n)

RSNetWorx for ControlNet Displays This Error 
Message On The Connection Status Tab Of The Scan 
List Configuration Screen

Exclusive Owner connection No Originator Application Data Available

Send Data connection No Target Application Data Available
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5-6        Once You Have Completed the Installation 
RSNetWorx for ControlNet 6.00.00 or later is required to display these error messages. If 
RSNetWorx for ControlNet 5.11.00 is used, �Unknown Error� will be displayed on the 
Connection Status tab of the scan list configuration screen.

Resolve the Errors
Follow this procedure to resolve error conditions on the PC containing the 1784-PKTCS card 
reporting the error:

1. Start the controlling application.

2. Verify that the size of the output data provided by the controlling application is as 
large as the output data configured in the scan list of the 1784-PKTCS card.

3. Verify that the controlling application has written the output data at least once.

Shut Down the Controlling Application Before You Download a Configuration to the 
Network or Modify the Scan List

You cannot modify or delete scan list entries of the 1784-PKTCS card that correspond to 
connections being controlled by your application.

• If you attempt to download a configuration to your network and connections are 
being controlled by your application, RSNetWorx for ControlNet displays the 
following screen:

If you see this screen, you should:

� Shut down the application that is controlling the connections.
� Use RSNetWorx to download the configuration to your network.
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Once You Have Completed the Installation        5-7
• If you modify or delete connections that are being controlled by your application, 
RSNetWorx for ControlNet displays the following screen when you attempt to save 
your changes:

If you see this screen, you should:

� Shut down the application that is controlling the connections.
� Save your changes in RSNetWorx.

Resource Calculations In RSNetWorx for ControlNet Software

RSNetWorx for ControlNet software calculates the 1784-PKTCS resources your 
configuration requires. These calculations are performed whether you are on line or off line 
with RSNetWorx. The 1784-PKTCS card can handle a particular configuration provided that:

• the number of scan list entries in the card is not more than 127
• the I/O Data File usage of the card is not more than 8192 16-bit words
• the Peak Scheduled usage of the card is not more than 100%,
• the CPU usage of the card is less than 100%
• the Consume and Produce usage of the card is not more than 100%
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5-8        Once You Have Completed the Installation 
Follow these steps to see the resources required for your configuration:

1. On the RSNetWorx for ControlNet main window, right-click the 1784-PKTCS card.

2.  Select Scanlist Configuration.

3. Select the Node Memory Usage tab to see the number of scan list entries used and the 
Data File usage.

4. Select the Node Network Usage tab to see the Peak Scheduled usage.

5. On the RSNetWorx for ControlNet main window, right-click the 1784-PKTCS card.
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Once You Have Completed the Installation        5-9
6. Select Properties�, and select the Device Usages tab to see the CPU usage and the 
Consume and Produce usage.

If the system exceeds any of the usage limits described previously, use RSNetWorx for 
ControlNet to reconfigure your system. Consider one or more of the following options:

• increase the Requested Packet Interval (RPI) of the entries in the scan list of 
 the1784-PKTCS card

• increase the Network Update Time (NUT) for your ControlNet network
• decrease the number of entries in the scan list of the 1784-PKTCS card
• decrease the Input and/or Output Sizes of the entries in the scan list of 

the1784-PKTCS card
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Chapter 6

Use IOView to Verify the Configuration

Included with the IOLinx for 1784-PKTCS driver CD is a stand-alone test application (called 
IOView.exe) that lets you diagnose simple problems over the network before the control 
application is available for integration.

In addition, you can use the test application to make certain that the 1784-PKTCS card has 
been correctly installed and is functioning in the PC.

Before You Begin
Before you begin, you must have done the following:

• Installed the card
• Connected it to the ControlNet network, and 
• Used RSNetWorx for ControlNet to load a scan list into the card

For Information On This Topic Refer To Page

Before You Begin 6-11

Start IOView 6-12

Create a View 6-12

Read Inputs and Write Outputs 6-14

Change the View State 6-16

Delete a View 6-16
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6-12        Use IOView to Verify the Configuration 
Start IOView
The test application IOView is automatically installed as part of the driver installation 
procedure.

To start IOView, click Start ⇒Programs ⇒Rockwell Software ⇒ IOLinx ⇒ IOLinx for 
ControlNet ⇒ Samples ⇒ IOView.

Create a View
The 1784-PKTCS card supports Network views and I/O Set (IoSet) views. A Network view 
encapsulates I/O data from all of the devices in the scan list. The data is organized according 
to the input and output addresses that you entered with the scanner configuration tool in 
RSNetWorx for ControlNet.

An I/O Set view encapsulates I/O data from one specified scan list entry. A scan list entry is 
specified by the Entry Name that you entered with the scanner configuration tool in 
RSNetWorx for ControlNet.

To create a view, follow these steps:

1. In IOView, select the port number of the 1784-PKTCS card for which you want to 
create a view.

TIP You may invoke multiple instances of IOView at the same time.
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Use IOView to Verify the Configuration        6-13
2. Create either a Network view or an I/O Set view.
• To create a Network view, select Edit ⇒ Create Network View.
• To create an I/O Set view, select Edit ⇒ Create I/O Set View.

You see this screen:

3. Select OK to create the view.

In This Field Do This

Port Number Verify the Port Number corresponds to the 1784-PKTCS card for which you 
want to create the view

Read/Write Period (ms) Select the Read/Write Period (in milliseconds)

Privilege Select whether the view is Read-Only or Read/Write

Watchdog Set the card-to-driver watchdog timeout (in milliseconds)

TIP Input data from a connection can be contained in multiple views. Output 
data for a connection can be contained only in one view which has 
Read/Write privileges.
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6-14        Use IOView to Verify the Configuration 
Read Inputs and Write Outputs
The input data (if any) and output data (if any) associated with the view are displayed in the 
Input Data and Output Data sections, respectively. 

Change the Read/Write Period
The data transfer between IOView and the card occurs at the Read/Write Period. You can 
change this period by moving the Read/Write Period slider.

Change Output Data
You can change output data for Read/Write views by doing one of the following:

• manually entering values into the Output Data section
• selecting a pre-determined output pattern

Move the 
Read/Write period 
slider to change 
the read/write 
period.
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Use IOView to Verify the Configuration        6-15
Manually Enter Values 

To manually enter the output values:

1. On the IOView screen, select Manual from the Output Pattern pull-down list.

2. In the Output data area of the IOView screen, enter the desired output values.

Select a Pre-determined Output Pattern 

When you select a setting other than Manual, IOView automatically generates the output data 
based on the selected pattern. To select a pre-determined output pattern, select a setting other 
than Manual from the Output Pattern pull-down list.

Select Manual 
from the Output 
Pattern pull-down 
list.

Enter the desired 
output values here.
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6-16        Use IOView to Verify the Configuration 
Change the View State
When the view is initially created, the view state is set to Idle. The view state must be set to 
Run in order for the I/O adapters and I/O modules to energize their outputs based on the 
output data associated with the view.

Set the view state to Run by selecting the Run radio button on the IOView screen. Once the 
view state is set to Run, active outputs are sent to the associated output devices.

Delete a View
To delete a view, either:

• In the left-hand pane of the IOView screen, select the view to be deleted, then select 
Edit ⇒ Delete View.

• Select File ⇒ Exit to shut down IOView.

ATTENTION Changing the view state to Run will cause the I/O adapters and I/O 
modules to energize their outputs based on the output data associated 
with the view.

Produced data for a Send Data connection will be sent to the consuming 
device and consumed data for a Receive Data From connection will be 
received from the producing device regardless of the view state.

To avoid personal injury and property damage, before setting the view 
state to Run, verify that the output values are appropriate for the 
consuming devices.

Select the Run radio 
button to change the 
view state to Run.
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Chapter 7

Interpret Status Indicators

The status indicators on the card give you information about the card and the network when 
the card is connected to the network with the BNC connectors. Table 7.1 outlines the states 
and explains what each state means to you and the action you should take, if any, to correct 
that state.

• steady - indicator is on continuously in the defined state.
• alternating - the two indicators alternate between the two defined states at the same 

time (applies to both indicators viewed together). The two indicators are always in 
opposite states, out of phase.

IMPORTANT When you connect the module to a ControlNet network using only the 
network access port (NAP), the status indicators are meaningless.

A

B

Redundant media 
BNC connectors

Diagnostic status 
indicators

42281

!

!

!
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7-2        Interpret Status Indicators 
• flashing - the indicator alternates between the two defined states (applies to each 
indicator viewed independent of the other). If both indicators flash, they must flash 
together, in phase.

Table 7.1  ControlNet status interpretation

 A      and    B
Cause: Action:

off • no power • none or apply power to the PC

• 1784-PKTCS card 
not configured

• Configure the card. See page 5-2.

• 1784-PKTCS 
driver not 
installed

• Install the driver. Refer to Chapter 3.

• faulted card • check operating system event log for details 
of fault (if the PC’s operating system supports 
an event log)

• cycle power to the PC

• verify that you have firmly inserted the 
1784-PKTCS card into a PCI local bus 
expansion slot and that the expansion slot 
screw is tightened

• if fault persists, contact your Rockwell 
Automation representative or distributor

steady red • faulted card • check operating system event log for details 
of fault (if the PC’s operating system supports 
an event log)

• cycle power to the PC

• verify that you have firmly inserted the 
1784-PKTCS card into a PCI local bus 
expansion slot and that the expansion slot 
screw is tightened

• if fault persists, contact your Rockwell 
Automation representative or distributor

alternating red/green • self-test • none

alternating red/off • incorrect node 
configuration

• duplicate 
ControlNet node 
address

• check 1784-PKTCS node address and other 
ControlNet configuration parameters

off • channel disabled • use RSNetWorx to configure the ControlNet 
network for redundant media, if required
Publication 1784-IN042A-EN-P - April 2005

User
新建印章



Interpret Status Indicators        7-3
1 UMAX is the highest node address on a ControlNet network that can transmit data.

steady green • normal operation • none

flashing green/off • temporary 
network errors

• check media for broken cables, loose 
connectors, missing terminators, etc.

• if condition persists, refer to the ControlNet 
Media Planning and Installation Manual, 
publication CNET-IN002

flashing red/off • media fault • check media for broken cables, loose 
connectors, missing terminators, etc.

• if condition persists, refer to the ControlNet 
Media Planning and Installation Manual, 
publication CNET-IN002

• no other nodes 
present on 
network

• add other nodes to the network

flashing red/green • incorrect node 
address

• change 1784-PKTCS node address so that it 

is less than or equal to UMAX1

• incorrect network 
configuration

• use RSNetWorx to reconfigure the 

ControlNet network so that UMAX1 is greater 
than or equal to the 1784-PKTCS node 
address

Table 7.1  ControlNet status interpretation

 A      and    B
Cause: Action:
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Appendix A 

Specifications

PCI local bus compliant to PCI Rev. 2.2 
The 1784-PKTCS card is compatible with 5V and 3.3V PCI slots, 
32-bit and 64-bit PCI slots, and PCI-X slots. 
Attention: The 1784-PKTCS card is not compatible with PCI 
Express and should not be inserted into a PCI Express slot.

mechanical form factor Universal PCI 32-bit short card 
4.2 in. (10.7cm) H x 6.5 in. (16.5cm) L

host PC requirements Microsoft .NET Framework 1.1 or later and one of the following 
operating systems:

• Microsoft Windows XP with Service Pack 1 or higher

• Microsoft Windows 2000 with Service Pack 4 or higher

Microsoft Windows NT 4.0 is not supported.

capacity 8192 16-bit words of I/O data file space 
127 scanlist entries for scheduled connections 
128 unscheduled connections 
50 unconnected messages

software compatibility Rockwell Software RSLinx 2.42.00 or later

Rockwell Software RSNetWorx for ControlNet

• 5.11.00 or later required

• 6.00.00 or later recommended

Rockwell Software RSLogix 5000

• V13 or later required

• V15 or later recommended

operational temperature IEC 60068-2-1 (Test Ad, Operating Cold), 
IEC 60068-2-2 (Test Bd, Operating Dry Heat), 
IEC 60068-2-14 (Test Nb, Operating Thermal Shock): 
0 to 55 °C (32 to 131 °F) 
The operating parameters describe the environment within the PCI 
slot. Refer to the documentation for your computer for 
environmental requirements. This card should not exceed those 
specifications.
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A-6        Specifications 
storage temperature IEC 60068-2-1 (Test Ab, Un-packaged Non-operating Cold), 
IEC 60068-2-2 (Test Bb, Un-packaged Non-operating Dry Heat), 
IEC 60068-2-14 (Test Na, Un-packaged Non-operating Thermal 
Shock): 
-40 to 85 °C (-40 to 185 °F)

relative humidity IEC 60068-2-30 (Test Db, Un-packaged Non-operating Damp Heat): 
5 to 95% non-condensing

vibration IEC 60068-2-6 (Test Fc, Operating): 
2g @ 10-500Hz

operating shock IEC 60068-2-27 (Test Ea, Unpackaged Shock): 
30g

non-operating shock IEC 60068-2-27 (Test Ea, Unpackaged Shock): 
50g

emissions CISPR 11: 
Group 1, Class A

ESD immunity IEC 61000-4-2: 
6kV contact discharges 
8kV air discharges

radiated RF immunity IEC 61000-4-3: 
10V/m with 1kHz sine-wave 80%AM from 80MHz to 2000MHz 
10V/m with 200Hz 50% pulse 100%AM at 900MHz 
10V/m with 200Hz 50% pulse 100%AM at 1890MHz

EFT/B immunity IEC 61000-4-4: 
+/-2kV at 5kHz on communications ports

surge transient immunity IEC 61000-4-5: 
+/-2kV line-earth (CM) on communications ports

conducted RF immunity IEC 61000-4-6: 
10Vrms with 1kH sine-wave 80% AM from 150kHz to 80MHz

enclosure type rating none (open-style)

power requirements In US, this equipment must be powered from UL Listed Information 
Technology Equipment or UL Listed Industrial Control Equipment. In 
Canada, this equipment must be powered by an SELV source, CSA 
Certified Information Technology Equipment, or CSA Certified 
Process Control Equipment. 
5V dc, 700mA maximum, Class 2

power dissipation 3.5W

isolation voltage (continuous-voltage 
withstand rating)

50V continuous 
Tested to withstand 500V for 60 seconds.
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Specifications        A-7
wiring category1 2 - on communications ports

certifications (when product is marked)2 UR      UL Recognized Component Industrial Control Equipment 
CSA   CSA Accepted Component for Process Control Equipment 
CSA    Accepted Component for Process Control Equipment in Class 
          I, Division 2 Group A,B,C,D Hazardous Locations 
CE      European Union 89/336/EEC EMC Directive, compliant with: 
          EN 50082-2; Industrial Immunity 
          EN 61326; Meas./Control/Lab., Industrial Requirements 
          EN 61000-6-2; Industrial Immunity 
          EN 61000-6-4; Industrial Emissions 
C-Tick Australian Radiocommunications Act, compliant with: 
          AS/NZS CISPR 11; Industrial Emissions 
CI      ControlNet International conformance tested to ControlNet 
         specifications

1 Use this Conductor Category information for planning conductor routing as described in the appropriate 
System Level Installation Manual.

2 See the Product Certification link at www.ab.com for Declarations of Conformity, Certificates, and other 
certification details.
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Rockwell Automation Support
Rockwell Automation provides technical information on the web to assist you in using its 
products. At http://support.rockwellautomation.com, you can find technical manuals, a 
knowledge base of FAQs, technical and application notes, sample code and links to software 
service packs, and a MySupport feature that you can customize to make the best use of these 
tools.

For an additional level of technical phone support for installation, configuration and 
troubleshooting, we offer TechConnect Support programs. For more information, contact 
your local distributor or Rockwell Automation representative, or visit 
http://support.rockwellautomation.com.

Installation Assistance

If you experience a problem with a hardware module within the first 24 hours of installation, 
please review the information that is contained in this manual. You can also contact a special 
Customer Support number for initial help in getting your module up and running:

New Product Satisfaction Return

Rockwell tests all of its products to ensure that they are fully operational when shipped from 
the manufacturing facility. However, if your product is not functioning and needs to be 
returned:

United States 1.440.646.3223
Monday – Friday, 8am – 5pm EST

Outside United 
States

Please contact your local Rockwell Automation representative for any 
technical support issues.

United States Contact your distributor. You must provide a Customer Support case number 
(see phone number above to obtain one) to your distributor in order to 
complete the return process.

Outside United 
States

Please contact your local Rockwell Automation representative for return 
procedure.
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Introduction_Catagory Types

		This tab summarizes Rockwell Automation Global Sales and Marketing preferred printing standards. It also provides guidance on whether a publication should be released as JIT (print on demand) or if it requires an RFQ for offset printing.
Find your publication type in the first section below. Use the assigned Printing Category information to determine the standard print specifications for that document type. The Printing Categories are defined below the Publication Type section. Note there may be slightly different print specifications for the categories, depending on the region (EMEA or Americas).
For more information on Global Sales and Marketing Printing Standards, see publication RA-CO004 in DocMan.

		Publication Type and Print Category

		Publication Type		Off Set Print Category Spec. (See table below)		JIT Spec. (See table below)		Description		Order Min		Order Max		Life Cycle Usage / Release Option

		AD		NA - Puttman		NA		Advertisement Reprint Colour		NA		NA		Presale / Internal

		AP		A3		D2		Application Solution or Customer Success Story		5		100		Presale / External

		AR		NA		NA		Article/Editorial/Byline		NA		NA		Presale / Internal

								/News Release (press releases should not be checked into DocMan or printed)

		AT		B3, B4		D5		Application Techniques		5		100		Presale / External

		BR		A2 Primary, A1		NA		Brochures		5		100		Presale / External

		CA		C2 Primary, C1		NA		Catalogue		1		50		Presale / External

		CG		NA		NA		Catalogue Guide		1		50		Presale / External

		CL		NA		NA		Collection		5		50		Presale / External

		CO		A5, A6, A9		D5		Company Confidential Information		NA		NA		NA / Confidential

		CP		E-only		E-only, D5		Competitive Information		5		50		NA / Confidential

		DC		E-only		E-only		Discount Schedules		NA		NA		Presale / Internal

		DI		A1, A3		NA		Direct Mail		5		100		Presale / Internal

		DM		NA		NA		Product Demo		5		50		Presale / Internal

		DS		B3		D5		Dimensions Sheet		1		5		Post / External

		DU		B3		D5		Document Update		1		5		Post / External

		GR		B2		D6		Getting Results		1		5		Post / External

		IN		B3		D5		Installation instructions		1		5		Post / External

		LM		NA		NA		Launch KitMaterials		5		50		Presale / Internal

		PC		B3		D5		Packaging Contents

		PL		E-only Primary, B3		E-only		Price List		5		50		Presale / Internal

		PM		B2		D6		Programming Manual		1		5		Post / External

		PP		A3		D1		Product Profile  NOTE: Application Solutions are to be assigned the AP pub type.		5		100		Presale / External

		QR		B2 Primary, B3, B5		D5, D6		Quick Reference		1		5		Post / External

		QS		B2 Primary, B3, B5		D5, D6		Quick Start		1		5		Post / External

		RM		B2		D5, D6		Reference Manual		1		5		Post / External

		RN		B3		D5		Release Notes		1		5		Post / External

		SG		B1 Primary, B4		D5, D6		Selection Guide Colour		5		100		Presale / External

		SG		B2		D5, D6		Selection Guide B/W		5		100		Presale / External

		SP		A1, A2, A3, A4		NA		Service ProfileSales Promotion NOTE: Service profiles are to be assigned the PP pub type.		5		100		Presale / Internal

		SR		B2, B3		D5, D6		Specification Rating Sheet		5		100		Presale / External

		TD		B2 Primary B3, B4, B5		D5, D6		Technical Data		5		100		Presale / External

		TG		B2, B3		D6		Troubleshooting Guide		1		5		Post / External

		UM		B2 Primary, B4		D6		User Manual B/W		1		5		Post / External

		WD		B3		D5		Wiring Diagrams / Dwgs		1		5		Post / Internal

		WP		B3 Primary, B5		D5		White Paper		5		100		Presale / External

		Pre-sale / Marketing		All paper in this category is White Brightness, 85% or better.  Opacity 87% or better

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		A1		4 color		170gsm  2pp		100# gloss cover, 100# gloss text

		A2		4 color		170gsm, folded, 4pp		100# gloss cover, 80# gloss text

		A3		4 color		Cover 170gsm with           Body 120gsm, > 4pp		80# gloss cover, 80# gloss text

		A4		2 color				80# gloss cover, 80# gloss text

						170gsm Silk – 120gsm Silk

		A5		2 color				80# gloss cover, 80# matt sheet text

						170gsm Silk – 120gsm Silk

		A6		1 color		170gsm Silk – 120gsm Silk		80# gloss cover, 80# matt sheet text

		A7		4 color cover				10 Point Cover C2S

				2 color text		Category being deleted		50# matte sheet text

				Selection Guide

		A8		4 color cover		Category being deleted		50# matte sheet text, self cover

				2 color text

				Selection Guide

		A9		2 color		100gsm bond		50# matte sheet text, self cover

				Selection Guide

		Post Sale / Technical Communication

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		B1		4 color cover		270gsm Gloss 100gsm bond		10 Point Cover C2S

				2 color text				50# matte sheet text

		B2		1 color				60# Cover

						160gsm Colortech & 100gsm Bond		50# matte sheet text

		B3		1 color				50# matte sheet text, self cover

						100gsm bond

		B4		2 color				60# Cover

						160gsm Colortech & 100gsm Bond		50# matte sheet text

		B5		2 color				50# matte sheet text, self cover

						100gsm bond

		Catalogs

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		C1		4 color cover		270gsm Gloss 90gsm silk		10 Point Cover C2S

				4 color text				45# Coated Sheet

		C2		4 color cover		270gsm Gloss 80gsm silk		10 Point Cover C2S

				2 color text				32#-33# Coated Sheet

		JIT / POD

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		D1		4 color		170gsm white silk		80# gloss cover, coated 2 sides

		D2		4 color		120gsm white silk		80# gloss text, coated 2 sides, self cover

		D3		4 color		Cover 170gsm  with           Body 120gsm		80# gloss cover, 80# gloss text coated 2 sides

		D4		1 color		160gsm tab		90# index

		D5		1 color		80gsm bond		20# bond, self cover

		D6		1 color		Cover 160gsm tab with Body 80gsm bond		90# index, 20# bond

		D7		2 color		160gsm tab		90# index

		D8		2 color		80gsm bond		20# bond, self cover

		D9		2 color		Cover 160gsm tab with Body 80gsm bond		90# index, 20# bond

		D10		Combination: 4 color cover, with 2 color body		Cover 160gsm with           Body 80gsm		90# index, 20# bond





Print Spec Sheet

		JIT Printing Specifications				RA-QR005D-EN-P  -  4/03/2009

		Printing Specification		YOUR DATA HERE		Instructions																																				NO

		(required) Category:		D5		Select Print Category A,B,C or D from category list, on "Introduction_Catagory Types" tab																														11” x 17”				LOOSE -Loose Leaf		YES		Pre-sale / Marketing				TOP

		(required) Finished Trim Size Width:		5.5” x 8.5” (half-size)																																8.5” x 11”				PERFECT - Perfect Bound				A1				LEFT

		(required) Publication Number :		1784-IN042A-EN-P		Sample: 2030-SP001B-EN-P																														3” x 5”				SADDLE - Saddle Stitch				A2				RIGHT				CORNER

		Use Legacy Number		NO		YES or NO																														18” x 24” Poster				PLASTCOIL - Plastic Coil (Coil Bound)				A4				BOTTOM				SIDE

		Legacy Number if applicable:				Sample Legacy Number: 0160-5.33																														24” x 36” Poster				STAPLED1 -1 position				A3

		Publication Title:		ControlNet Universal PCI Scanner Card		Sample: ElectroGuard Selling Brief																														36” x 24” Poster				STAPLED1B - bottom 1 position				A5

		(required) Business Group:		Marketing Commercial		As entered in DocMan																														4” x 6”				STAPLED2 - 2 positions				A6

		(required) Cost Center:		19021		As entered in DocMan - enter number only, no description. Example - 19021		CMKMKE CM Integrated Arch - 19021
CMKMKE Market Access Program - 19105																												4.75” x 7” (slightly smaller half-size)				THERMAL - Thermal bound (Tape bound)				A7

		Binding/Stitching:		SADDLE - Saddle Stitch		Review key on right...		Saddle-Stitch Items 
All page quantities must be divisible by 4.
20 sheets max. on 20# (text and cover); 20 sheets = 80-page pub
16 sheets max. on 20# (text) and 90# (cover); 16 sheets = 64-page pub

Perfect Bound Items
475 sheets max. on 20# no cover; 475 sheets = 950-page pub
470 sheets max. w/cover / 90# index unless indicated otherwise); 470 sheets = 940-page pub

Coil Bound Items
400 sheets max. of 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise); 400 sheets = 800-page pub

Tape Bound Items
125 sheets max. on 20# no cover; 125 sheets = 250-page pub
120 sheets max. w/cover (90# index unless indicated otherwise); 120 sheets = 240-page pub

Double Wire Bound Items
250 sheets max. on 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise); 250 sheets = 500-page pub																												4.75” x 7.75”				THERMALO - Thermal Bound (Tape bound - offline)				A8

		(required) Page Count of Publication:		70		Total page count including cover																														5.5” x 8.5” (half-size)				Wire O - Double Wire Bound (offline)				A9

		Paper Stock Color:		White		White is assumed.  For color options contact your vendor.																														6” x 4”								Post Sale / Technical Communication

		Number of Tabs Needed:				5 tab in stock at RR Donnelley																														7.385” x 9” (RSI Std)								B1

		Stitching Location:				Blank, Corner or Side																														8.25” x 10.875”								B2

		Drill Hole YES/NO		NO		All drilled publications use the 5-hole standard, 5/16 inch-size hole and a minimum of ¼ inch from the inner page border.																														8.25” x 11” (RA product profile std)								B3

		Glue Location on Pad:				Glue location on pads																														8.375” x 10.875								B4

		Number of Pages per Pad:				Average sheets of paper.. 25, 50 75,100 Max																														9” x 12” (Folder)								B5

		Ink Color				One color assumes BLACK / 4 color assume CMYK / Indicate PMS number here…																														A4 (8 ¼” x 11 ¾”) (210 x 297 mm)								Catalogs

		Used in Manufacturing:		YES																																A5 (5.83” x 8.26”) (148 x 210 mm)								C1

		Comments:																																										C2

		Part Number:		957689-40																																								JIT / POD
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																																												D3
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